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1. Data Table  

1.1 Overview 

Data Tables are a tool used frequently in Excel models to track how small changes in inputs affect 

the results of formulas in your model that are dependent on those inputs. An analysis of this sort is 

often termed a sensitivity analysis. Excel has two varieties of Data Table: 

 The One-Variable Data Table 

 The Two-Variable Data Table 

 

1.2 The One-Variable Data Table 

The One-Variable Data Table allows you to identify a single decision variable in your model and 

see how changing the values for that variable affect the values calculated by one or more formulas 

in your model. 

 Formula 

Input Value 1 Result 

Design your one-variable Data Table so that input values are listed either down a column 

(column-oriented; most common) or across a row (row-oriented). Formulas used in a one-variable 

Data Table must refer to an input cell for your spreadsheet model. 

1. Type the list of values you want to substitute in the input cell either down one column or across 

one row. 

2. If the input values are listed down a column, type the formula in the row above the first value 

and one cell to the right of the column of values. Type any additional formulas to the right of the 

first formula. If the input values are listed across a row, type the formula in the column to the 

left of the first value and one cell below the row of values. Type any additional formulas below 

the first formula. 
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3. Select the range of cells that contains the formulas and values you want to substitute. 

4. From the menus choose Data tab, What-If Analysis group, Data Table. Excel displays the 

Table dialog that asks you to identify the cell reference for the input cell.  

• If the Data Table is column-oriented, type the cell reference for the input cell in the 

“Column input cell” box.  

• If the Data Table is row-oriented, type the cell reference for the input cell in the “Row input 

cell” box. 

  

5. Click [OK] to have Excel execute the Data Table and fill the Data Table matrix with values. 

Understanding how to structure your Data Table and respond to the “Table” dialog prompt is the 

key to a successful Data Table. 

 

1.3 The Two-Variable Data Table 

With the Two-Variable Data Table you can specify two decision variables and a variety of inputs 

and only a single formula. 

Formula Input Value 2 

Input Value 1 Result 

1. Type the list of values you want to substitute in the input cell either down one column or across 

one row, we could set up a Two-Variable Data Table to look like this: 

2. In the upper left-hand cell of the Data Table is a copy of the formula from elsewhere in the 

model or a reference to the cell that holds the formula in the model. 
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3. Execute the Two-Variable Data Table in the same way you would execute the One-Variable 

Table. That is, select the entire matrix to the right and below the values you’ve specified. From 

the menus choose Data tab, What-If Analysis group, Data Table. Excel displays the Table 

dialog that asks you to identify the cell reference for the input cell. 

4. This time, because you’ve specified two inputs, you must enter values for both Row input cell 

and Column input cell in the “Data Table” dialog. 

 

5. Click the [OK] button to execute the Data Table and see the results: 
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2. Scenario Manager 

2.1 Overview 

To model problems that are more complicated than data tables can handle, involving as many as 32 

variables, you can call on the services of the Scenario Manager in Excel. A scenario is a named 

combination of values that is assigned to one or more variable cells in a what-if model. You can use 

the Scenario Manager to enter variable figures in your what-if model and watch the effect on 

dependent computed values. 

Here are some of the things you can do with the Scenario Manager in Excel: 

 Create multiple scenarios for a single what-if model, each with its own sets of variables. You 

can create as many scenarios as your model necessitates.  

 Distribute a what-if model to members of your team so that they can add their own scenarios. 

Then you can collect the versions and merge all the scenarios onto a single worksheet.  

 Using Scenario Summary, examine relationships between scenarios created by multiple users. 

2.2 Creating a Scenario 

A scenario is a named what-if model that includes variable cells linked together by one or more 

formulas. Before you create a scenario, you must design your worksheet so that it contains at least 

one formula that’s dependent on cells that can be fed different values.  

For example, you might want to compare best-case and worst-case scenarios for sales in a coffee 

shop, based on the number of cups of coffee sold in a week. The following figure shows a 

worksheet that contains three variable cells and several formulas that can serve as the basis for 

several scenarios. In the following example, we will use this worksheet to show how to create a 

best-case and a worst-case sales scenario. 
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To create a scenario using the active workbook, follow these steps: 

1. Click Data tab, What-If Analysis group, and click Scenario Manager to open the Scenario 

Manager dialog box. 

2. Click the [Add] button to open the Add Scenario dialog box for creating your first scenario. 

 
3. Type “Best Case” in the Scenario Name box. In the Changing Cells box, specify the variable 

cells that you want to modify in your scenario. You can type cell names, highlight a cell range, 

or hold down the [Ctrl] key while you click individual cells to add them to the text box. To 

follow our example, hold down the [Ctrl] key while you click cells D5, D9, and D13. 

 

4. Click the [OK] button in the Add Scenario dialog box to add your scenario to the Scenario 

Manager. You’ll see the Scenario Values dialog box, which asks you for your model’s variables. 

Type 150, 225 and 125 in the as the scenario values. 
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5. Click the [Add] button in the Scenario Values dialog box to return to the Add Scenario dialog 

box, where you’ll create a second scenario.  

6. Type “Worst Case” in the Scenario Name box, and then click the [OK] button to open the 

Scenario Values dialog box again.  

 

7. In the Scenario Values dialog box, type 50, 40, and 30 in the boxes for the variable cells, and 

then click the [OK] button. (These values represent our guess at the worst case.) 

 

8. The Scenario Manager dialog box opens, listing the “Best Case” and “Worst Case” scenarios 

that you just created. Now you’re ready to view the results of your forecasting models. 

9. Click the [Close] button to close the Scenario Manager dialog box 

2.3 Viewing a Scenario 

When you view a scenario, Excel replaces the current values on your worksheet with the values 

stored in the scenario. If you want to load a scenario but still be able to restore the previous values 

on the worksheet, be sure to save your file before loading the scenario. To view a scenario, follow 

these steps: 

1. Excel keeps track of each of your worksheet scenarios. You can view them by clicking Tools ➔ 

Scenarios for your active worksheet to open the Scenario Manager dialog box. 

2. In the Scenarios list, select the scenario that you want to view and click the [Show] button. 

Excel will substitute the values in the scenario for the variables on your worksheet and display 

the results on your worksheet, as shown in the preceding figure (The Scenario Manager dialog 

box will remain open. You might need to move it to view the results). 

3. Select additional scenarios, and click the [Show] button to compare and contrast the various 

what-if models on your worksheet.  
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4. When you’re finished, click the [Close] button to close the Scenario Manager dialog box. The 

last active scenario will remain on your worksheet. 

 

2.4 Creating Scenario Reports 

Although you can easily compare different scenarios by switching between them using the [Show] 

button in the Scenario Manager dialog box, you might occasionally want to view a report that 

contains consolidated information about the scenarios on your worksheet. You can accomplish this 

quickly by clicking the [Summary] button in the Scenario Manager dialog box. Excel will 

automatically format the summary report and copy it to a new worksheet in your workbook. To 

create a scenario report, follow these steps: 

1. Activate the worksheet containing the scenario or scenarios you want to use for your report.  

2. Click Tools ➔ Scenarios to display the Scenario Manager dialog box.  

3. Click the [Summary] button to open the Scenario Summary dialog box. 

 

4. The Scenario Summary dialog box prompts you for a result cell to total in the report, and also 

for a report type.  

 A scenario summary report is a formatted table that appears on its own worksheet.  

 A PivotTable report is a special summary table whose rows and columns can be rearranged, 

or pivoted. 

5. Select the result cell that you want to total (cell G4 in this example), click the report option 

button that you want to use (accept the Scenario summary default if you’re not sure), and then 

click the [OK] button.  
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6. After a short pause, a new Scenario Summary tab will appear in your workbook, as shown in the 

following figure. The outlining buttons in your report’s left and top margins will help you shrink 

or expand the rows and columns in your scenario summary. Excel uses the defined names for 

variable cells D5, D9, and D13, which results in a more comprehensible summary. 

 

2.5 Managing your Scenarios 

Once you’ve defined a scenario by using the [Add] button, luckily you’re not stuck with that 

scenario forever. You can edit and delete scenarios by clicking the [Edit] and [Delete] buttons in the 

Scenario Manager dialog box.  

The [Edit] button lets you change the name of the scenario, remove existing variable cells, add new 

variable cells, or even choose a completely new group of variables. To assign different values to the 

variable cells in a scenario, clear the “Prevent Changes” option in the Edit Scenario dialog box. 

After you click the [OK] button, Excel will display the Scenario Values dialog box. Make any 

changes you want to make, and then click the [OK] button. 

To remove a particular scenario permanently, simply select it in the Scenario Manager dialog box, 

and then click the [Delete] button. 

Finally, you can copy scenarios into the active worksheet from any other worksheet in a currently 

open workbook. To do this, click the Merge button in the Scenario Manager dialog box, and then 

specify a source workbook and worksheet in the Merge Scenarios dialog box. 
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2.6 Add Scenario to Excel Ribbon 

An easier way to switch between scenarios is to add a command to the Ribbon.  

1. Right-click on the Ribbon, and click Customize the Ribbon 

2. From the drop down list at the top left, select “All Command”. In the list of commands that are 

currently on the Ribbon, click the plus sign for “Data”, then click “Data Tools”. That group 

contains the Scenario Manager, so we'll add the new group beside it. 

 

3. Click the [New Group] button, then click the [Rename] button, type Scenario as the name for 

the group, and click [OK]. 

 

4. At the left, in the list of “All Commands”, scroll down to find “Scenarios”. Click on “Scenarios, 

then click [Add], to put Scenarios in the Scenario group. 

 

5. Click OK, to close the window, then click the Data tab, and select a Scenario to view. 
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3. Goal Seek 

Goal Seek is part of a suite of commands sometimes called what-if analysis tools. When you know 

the desired result of a single formula but not the input value the formula needs to determine the 

result, you can use the Goal Seek feature available by clicking Data tab, What-If Analysis group, 

Goal Seek on the menu. When goal seeking, Microsoft Excel varies the value in one specific cell 

until a formula that's dependent on that cell returns the result you want.  

To use Goal Seek, set up your worksheet to contain the following: 

 A formula that calculates your goal (for example, a formula that calculates the total CD sales 

revenue)  

 An empty variable cell for the unknown number that will produce the desired outcome (for 

example, a cell to hold the number of CDs you must sell to reach $1 million in sales)  

 Values in any cells (other than the empty cell) that the formula refers to (for example, a cell 

that stores the price of a CD)  

The empty cell should be referenced in your formula; it serves as the variable that Excel changes. 

When the Goal Seek command starts to run, it repeatedly tries new values in the variable cell to find 

a solution to the problem you’ve set. This process is called iteration, and it continues until Excel has 

run the problem 100 times or has found an answer within .001 of the target value you specified. 

(You can adjust these iteration settings by clicking Options on the Tools menu, and then adjusting 

the Iteration options on the Calculations tab). Because it calculates so fast, the Goal Seek command 

can save you significant time and effort over the brute force method of trying one number after 

another in the formula.  

To forecast using the Goal Seek command, follow these steps: 

1. Create a worksheet that contains a formula, an empty variable cell (in yellow color) that will 

hold your solution, and any data you need to use in your calculation. For example, set up a 

worksheet to determine the number of cups of coffee priced at $1.75 that you would have to 

sell to gross $1,000,000 

 

2. In your worksheet, select the cell containing the formula, and then click Data tab, What-If 

Analysis group, Goal Seek to open the Goal Seek dialog box. The dialog box asks you to 

supply three variables, indicate set cell1 to value by changing cell2. Then type the goal that 
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you want to reach in the To value box. For example, to reach $1,000,000 in sales. Finally, 

input the By changing cell text box, collapse the Goal Seek dialog box, if necessary, and then 

click the blank cell that is to contain your answer (the variable cell) 

3. The Goal Seek command will calculate the value for this blank cell by using your goal in the 

To value text box and the formula in the cell referenced in the Set cell text box. The variable 

cell will be indicated by a selection marquee (cell D6 in this example): 

 

4. Click the [OK] button to find a solution for your sales goal. Excel will display the Goal Seek 

Status dialog box when the iteration is complete, and the result of your forecast will appear in 

the worksheet, as shown in the following figure. This forecast shows that you need to sell 

571,429 coffees at $1.75 per cup to reach your sales goal of $1,000,000. Click the [OK] button 

to close the Goal Seek Status dialog box. 
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4. Solver 

4.1 Introduction 

When your forecasting problem contains more than one variable, you need to use the Solver add-in 

utility to analyze the scenario. Veterans of business school will happily remember multivariable 

case studies as part of their finance and operations management training.  

In this example we’re running a coffee shop that currently sells three beverages: regular 

fresh-brewed coffee, premium caffe latte, and premium caffe mocha. We currently price regular 

coffee at $1.25, caffe latte at $2.00, and caffe mocha at $2.25, but we’re not sure what our revenue 

potential is and what emphasis we should give to each of the beverages (Although the premium 

coffees bring in more money, their ingredients are more expensive and they take more time to make 

than regular coffee). We can make some basic calculations by hand, but we want to structure our 

sales data in a worksheet so that we can periodically add to it and analyze it using the Solver.  

4.2 Loading the Solver Add-in 

The Solver is an add-in utility, so you should verify that it’s installed on your system before you get 

started.  

1. Click the Microsoft Office Button, and then click Options. 

2. Click Add-Ins, and then in the Manage box, select Solver Add-ins. Click Go. 

 

  



   Chapter 4 

Excel for Financial Modelling and Data Analysis @ Peter Lo 2023 13 

3. In the Add-Ins available box, select the Solver Add-in check box, and then click OK. 

 

4. After you load the Solver Add-in, the Solver command is available in the Analysis group on 

the Data tab. 
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4.3 Setting up the Problem 

The first step in using the Solver command is to build a Solver-friendly worksheet. This involves 

creating a target cell to be the goal of your problem—for example, a formula that calculates total 

revenue—and assigning one or more variable cells that the Solver can change to reach your goal. 

Your worksheet can also contain other values and formulas that use the target cell and the variable 

cells. In fact, for the Solver to do its job, each of your variable cells must be precedents of the target 

cell. (In other words, the formula in the target cell must reference and depend on the variable cells 

for part of its calculation.) If you don’t set it up this way, when you run the Solver you’ll get the 

error message “The Set Target Cell values do not converge”. 

The figure shows a simple worksheet that we can use to estimate the weekly revenue for our 

example coffee shop and to determine how many cups of each type of coffee we will need to sell.  

The three variable cells in the worksheet are cells D5, D9, and D13—these are the blank cells 

whose values we want the Solver to determine when it finds a way to maximize our weekly 

revenue. 

In the bottom-right corner of our screen is a list of constraints we plan to use in our forecasting. A 

constraint is a limiting rule or guiding principle that dictates how the business is run. For example, 

because of storage facilities and merchandising constraints, we’re currently able to produce only 

500 cups of coffee (both regular and premium) per week. In addition, our supply of chocolate 

restricts the production of caffe mochas to 125 per week, and a milk refrigeration limitation restricts 

the production of premium coffee drinks to 350 per week. 

 

 

 



   Chapter 4 

Excel for Financial Modelling and Data Analysis @ Peter Lo 2023 15 

4.4 Running the Solver 

After you’ve defined your forecasting problem in the worksheet, you’re ready to run the Solver 

add-in. The following steps show you how to use the Solver to determine the maximum weekly 

revenue for your coffee shop given the following constraints: 

 No more than 500 total cups of coffee (both regular and premium)  

 No more than 350 cups of premium coffee (both caffe latte and caffe mocha)  

 No more than 125 caffe mochas  

In addition to telling you the maximum revenue, the Solver calculates the optimum distribution of 

coffees in the three coffee groups. To use the Solver, complete the following steps: 

1. Click the target cell—the one containing the formula that’s based on the variable cells you 

want the Solver to determine. In our example, the target cell is G4.  

2. Choose Solver To open the Solver Parameters dialog box: 

 

3. If the Set Target Cell text box doesn’t already contain the correct reference, select the text box 

and then click cell G4 to insert $G$4 as the target cell.  

4. Select the Max option following the Equal To label, because you want to find the maximum 

value for the target cell.  

5. Click the button at the right end of the By Changing Cells text box to collapse the dialog box. 

Select each of the variable cells. If the cells adjoin one another, simply select the group by 

dragging across the cells. If the cells are noncontiguous, as in our example, hold down the 

[Ctrl] key and click each cell (this will place commas between the cell entries in the text box). 
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6. In our example, select cells D5, D9, and D13 (the three blank cells reserved for the number of 

cups of coffee that need to be sold in each category), which will place the following value in 

the By Changing Cells text box: $D$5,$D$9,$D$13. 

 

7. If you click the [Solve] button, the Solver tries to guess at the variable cells in your forecasting 

problem. The Solver creates the guess by looking at the cells referenced in the target cell 

formula. Don’t rely on this guess, though—it’s often incorrect!  

Constraints aren’t required in all Solver problems, but this problem has three. Click the [Add] 

button to add the first constraint using the Add Constraint dialog box. 

8. The first constraint is that you can sell only 500 cups of coffee in one week. To enter this 

constraint, click cell G8 (the cell containing the total cups formula), select <= in the operator 

drop-down list, and with the insertion point in the Constraint text box, click G11 or type 

Max_cups, using the underline character to link the words (Max_cups is the name of cell G11 

in our example). When you’re done, click the [Add] button in the Add Constraint dialog box 

to enter the first constraint. You have the option of typing a value, clicking a cell, or entering a 

cell reference or name in the Constraint text box. If you click a cell that has a defined name, 

Excel will use that name when you add the constraint 
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9. Define the second constraint—you can sell only 350 premium coffees in one week. With the 

insertion point in the Cell Reference text box, click cell G7 (the cell containing the premium 

cups formula), select <= in the operator drop-down list, and in the Constraint text box, type 

Max_premium (the name of cell G12) or click cell G12. When you’re finished, click the Add 

button to enter the second constraint. 

 

10. Define the third constraint—you can sell only 125 caffe mochas in one week. Click cell D13 

(the variable cell containing the number of mocha cups), select <= in the operator drop-down 

list, and in the Constraint text box, type Max_mocha (the name of cell G13) or click cell G13.  

 

11. Click the [OK] button in the Add Constraint dialog box to display all three constraints in the 

Solver Parameters dialog box. 
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12. To modify one of the constraints that appears in the Solver Parameters dialog box, select the 

constraint and click the [Change] button. To customize the iteration and calculation parameters 

in the Solver utility, click the [Options] button and make your adjustments.  

13. Your forecasting problem is ready to go, so click the [Solve] button to calculate the result. 

After a brief pause the Solver will display the Solver Results dialog box describing how the 

optimization analysis went. If the Solver runs into a problem, you’ll see an error message, and 

you can click the [Help] button to learn more about the difficulty.  

 

14. To display the new solution in your worksheet, select the Keep Solver Solution option in the 

Solver Results dialog box and then click the [OK] button. The Solver will place an optimum 

value in the target cell (Orange color) and will fill the variable cells (Yellow color) with the 

solutions that best match the constraints you specified. 
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4.5 The Types of Solving Methods 

The three methods to solve the data in the excel solver are listed as follows: 

4.5.1 GRG Nonlinear 

GRG stands for “Generalized Reduced Gradient”. In its most basic form, this solver method looks 

at the gradient or slope of the objective function as the input values (or decision variables) change 

and determines that it has reached an optimum solution when the partial derivatives equal zero. Of 

the two nonlinear solving methods, GRG Nonlinear is the fastest. That speed comes with a 

compromise though. 

The downside is that the solution you obtain with this algorithm is highly dependent on the initial 

conditions and may not be the global optimum solution. The solver will most likely stop at the local 

optimum value nearest to the initial conditions, giving you a solution that may or may not be 

optimized globally. 

Another requirement for the GRG nonlinear solver to obtain a good solution is for the function to be 

smooth. Any discontinuities caused by IF, VLOOKUP, or ABS functions, for example, will cause 

problems for this algorithm. 

 

4.5.2 Simplex LP 

“LP” stands for Linear Problems. This method helps solve linear programming problems and works 

faster than the GRG nonlinear method. In a linear programming problem, a single objective has to 

be maximized or minimized subject to certain conditions. The simplex LP and GRG nonlinear 

method both are used for smooth problems. 

4.5.3 Evolutionary 

The Evolutionary algorithm is more robust than GRG Nonlinear because it is more likely to find a 

globally optimum solution. However, this solver method is also very slow. 
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The Evolutionary method is based on the Theory of Natural Selection – which works well in this 

case because the optimum outcome has been defined beforehand. In simple terms, the solver starts 

with a random “population” of sets of input values. These sets of input values are plugged into the 

model and the results are evaluated relative to the target value. 

The sets of input values that result in a solution that’s closest to the target value are selected to 

create a second population of “offspring”. The offspring are a “mutation” of that best set of input 

values from the first population. The second population is then evaluated and a winner is chosen to 

create the third population. This goes on until there is very little change in the objective function 

from one population to the next. 

 

4.6 Editing your Solver  

Perhaps the best feature of a Solver forecast is that you can easily edit it to evaluate new goals and 

contingencies. For example, if you decide that you want to earn exactly $700 per week from coffee 

drinks, you can use the Solver to tell you what the optimum combination of drinks would be. 

Setting a target value in the Solver is a little like using the Goal Seek command to determine a value 

for an unknown variable, although with Solver you can use more than one variable. 

To edit the Solver forecast you created in the previous exercise to find the variables needed to reach 

a specific goal, follow these steps: 

1. Activate the worksheet in which you previously used the Solver. In the variable cells, leave the 

values that were generated by the Solver in the previous exercise (namely, 150 in D5, 225 in 

D9, and 125 in D13).  

2. Choose Tools ➔ Solver. The Solver Parameters dialog box will appear, still displaying the 

target, variables, and constraints from your last Solver problem. You’ll adjust these to compute 

a new forecasting goal.  

3. Select the Value Of option and type 700 in the text box to the right. The Value Of option sets 

the target cell to a particular goal so that you can determine the variable mix you need to reach 

your milestone (In this example, the variable cells represent the numbers of cups of different 

types of coffee). 
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4. Click the [Solve] button to find a solution to your forecasting problem. When the Solver has 

finished, click the [OK] button in the Solver Results dialog box. 
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4.7 What if there is more than one Solution to the Problem? 

In the previous example, the Solver determined that you could sell 100 mochas, 175 lattes, and 100 

regular coffees to reach your sales goal of $700. But you can also reach the $700 mark using a 

different product mix; for example, you could sell 94 regular coffees, 151 lattes, and 125 mochas to 

reach $700 (Using this mix, your revenue would actually be $700.75). So, how did the Solver 

decide what the optimum product mix would be? The Solver simply started with the current 

numbers in the variable cells and adjusted them until it found an acceptable solution. This is why, if 

you use different starting values in the variable cells before you run the Solver, you can get different 

results from a problem with multiple solutions. 

4.8 What if Solver reaches its iteration limit without Finding a Solution? 

The starting values in the variable cells can affect the solution: Solver might fail to find a solution 

or it might time out before reaching a solution. Enter values in variable cells that fall close to what 

you believe the final values will be. If Solver still reaches its iteration limit without arriving at a 

solution, you can adjust the starting values and restart or click [Continue] to use the maximum 

solution time. You can adjust both the maximum iterations and maximum time by using the 

[Options] button in the Solver Parameters dialog box. 

If you would like to use a particular product mix, you can take advantage of the way the Solver 

reaches its results. Enter the values that you think might be acceptable in the variable cells before 

you run the Solver, and Excel will use those as starting values when it computes the solution. 

4.9 Configuration for Solver 

We can control many aspects of how Solver will solve a problem. 

 Constraint Precision: Specify how close the Cell Reference and Constraint formulas must be 

to satisfy a constraint. Specifying less precision will make Excel solve the problem more 

quickly. 

 Use Automatic Scaling: It is used when the problem deals with large differences in 

magnitude— when you attempt to maximize a percentage, for example, by varying cells that 

are very large. 

 Show Iteration Results: By selecting this checkbox, Solver is instructed to pause and display 

the results after each iteration. 

 Ignore Integer Constraints: If you select this check box, Solver will ignore constraints that 

mention that a particular cell must be an integer. Using this option may permit Solver to find a 

solution that can’t be found otherwise. 

 Max Time: Mention the maximum amount of time (in seconds) that you want Solver to spend 

on a single problem. If Solver reports that it exceeded the time limit, you can increase the 

amount of time that it will spend searching for a solution. 

 Iterations: Enter the maximum number of trial solutions that you want Solver to try to solve 

the problem. 

 Max Subproblems: It is used to solve complex problems. Specify the maximum number of 

sub-problems that may be solved by the Evolutionary algorithm. 
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 Max Feasible Solutions: It is used for complex problems. Specify the maximum number of 

feasible solutions that may be solved by the Evolutionary algorithm. 

 
  



   Chapter 4 

Excel for Financial Modelling and Data Analysis @ Peter Lo 2023 24 

5. Using Subtotals to Analyst a List 

 

Microsoft Excel can automatically calculate subtotal and grand total values in a list. When you 

insert automatic subtotals, Excel outlines the list so that you can display and hide the detail rows for 

each subtotal. 

To insert subtotals, you first sort your list so that the rows you want to subtotal are grouped together. 

You can then calculate subtotals for any column that contains numbers by selecting Data tab and 

click Subtotal. 

 

5.1 How Subtotals are Calculated 

5.1.1 Subtotals     

Excel calculates subtotal values with a summary function, such as Sum or Average. You can display 

subtotals in a list with more than one type of calculation at a time. 

5.1.2 Grand Totals     

Grand total values are derived from detail data, not from the values in the subtotal rows. For 

example, if you use the Average summary function, the grand total row displays an average of all 

detail rows in the list, not an average of the values in the subtotal rows. 

5.1.3 Automatic Recalculation     

Excel recalculates subtotal and grand total values automatically as you edit the detail data. 
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5.2 Create Summary Reports    

1. Sort the column you wish to perform subtotal. 

2. Select Data tab, and then click Subtotals to popup the Subtotal dialog box 

3. In the At each change in box, click the column to subtotal.  

4. In the Use function box, click the summary function that you want to use to calculate the 

subtotals. In the example above, you would select Sum.  

5. In the Add subtotal to box, select the check box for each column that contains values that you 

want to subtotal. By default, Excel offers to subtotal the last column of your data. 

6. If you want an automatic page break following each subtotal, select the Page break between 

groups check box.  

7. To specify a summary row above the details row, clear the Summary below data check box. 

To specify a summary row below the details row, select the Summary below data check box. In 

the example above, you would clear the check box.  

8. Optionally, you can use the Subtotals command again by repeating steps one through seven to 

add more subtotals with different summary functions. To avoid overwriting the existing 

subtotals, clear the Replace current subtotals check box. 

9. Click [OK] to confirm. Excel inserts a new row at each change of column and calculates a 

subtotal. After you have the subtotals in, you will see small 1, 2, and 3 buttons appear below 

the name box. Click the 2 button to see just one line per account with the totals. Click the 3 

button to see all lines. 
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6. Grouping 

 

If you have a list of data that you want to group and summarize, you can create an outline of up to 

eight levels, one for each group. Each inner level, represented by a higher number in the outline 

symbols displays detail data for the preceding outer level, represented by a lower number in the 

outline symbols. Use an outline to quickly display summary rows or columns, or to reveal the 

detailed data for each group. You can create an outline of rows, an outline of columns, or an outline 

of both rows and columns. 

 

1. To display rows for a level, click the appropriate 

 outline symbols. 

2. Level 1 contains the total sales for all detail rows. 

3. Level 2 contains total sales for each month in each 

region. 

4. Level 3 contains detail rows (only detail rows 11 

through 13 are currently visible). 

5. To expand or collapse data in your outline, click the 

 and  outline symbols. 

 

6.1 Create an Outline of Rows 

1. Make sure that each column of the data that you want to outline has a label in the first row, 

contains similar facts in each column, and that the range has no blank rows or columns. 

2. Select a cell in the range.  

3. To sort the column that contains the data you want to group by, select that column, and then on 

the Data tab, in the Sort & Filter group, click Sort A to Z or Sort Z to A. 

4. Insert summary rows. To outline data by rows, you must have summary rows that contain 

formulas that reference cells in each of the detail rows for that group.  

 Insert summary rows by using the Subtotal command. Use the Subtotal command, which 

inserts the SUBTOTAL function immediately below or above each group of detail rows 

and automatically creates the outline for you. For more information, see Insert subtotals in 

a list of data in a worksheet. 

 Insert your own summary rows. Insert your own summary rows with formulas 

immediately below or above each group of detail rows. 

5. Specify whether the location of the summary row is below or above the detail rows. To specify 

a summary row above the details row, clear the Summary rows below detail check box. To 

specify a summary row below the details row, select the Summary rows below detail check 

box. 

  



   Chapter 4 

Excel for Financial Modelling and Data Analysis @ Peter Lo 2023 27 

6. Outline the data 

 Outline the outer group. 

 outline an inner, nested group. 

 Continue selecting and grouping inner rows until you have created all of the levels that 

you want in the outline. 

 If you want to ungroup rows, select the rows, and then on the Data tab, in the Outline 

group, click Ungroup.  

6.2 Showing and Hiding Data 

To show or hide a group: 

1. Click the minus sign—also known as the Hide Detail symbol—to collapse the group. 

 

2. Click the plus sign—also known as the Show Detail symbol—to expand the group again. 
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6.3 Removing Groups and Subtotaling 

To ungroup data: 

1. Select the rows or columns you want to ungroup. In this example, we'll ungroup size Small. 

Selecting cells to ungroup 

 

2. From the Data tab, click the Ungroup command. The range of cells will be ungrouped. 

Ungrouping the selected cells 
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7. Consolidating Data in Multiple Worksheets 

7.1 Overview 

To summarize and report results from multiple worksheets, you can consolidate data from each 

worksheet into a master worksheet. The worksheets can be in the same workbook or other 

workbooks. When you consolidate data, you are assembling data so you can more easily update and 

aggregate it on a regular or ad hoc basis.  

For example, if you have a worksheet of expense figures for each of your regional offices, you 

might use a consolidation to roll up these figures into a corporate expense worksheet. This master 

worksheet might contain sales totals and averages, current inventory levels, and highest selling 

products for the entire enterprise. 

 

To consolidate data, you use the Data tab, and then Consolidate to display the Consolidate dialog 

box.  

 
You can use this dialog box in several ways to consolidate your data:  

Position Use this approach when the data in all worksheets is arranged in identical order 

and location. 

Category  Use this approach when each worksheet organizes the data differently, but has 

the same row and column labels, which you can use to match the data. 

3-D Formulas Use this approach when the worksheets do not have a consistent pattern you can 

rely on. You can create formulas that refer to cells in each range of data that 

you're combining. Formulas that refer to cells on multiple worksheets are called 

3-D formulas 
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7.2 Consolidate by Position or Category 

Consolidate by position when the data in all source areas is arranged in identical order and location; 

for example, if you have data from a series of worksheets that were created from the same template, 

you can consolidate the data by position. 

Consolidate by category when you want to summarize a set of worksheets that have the same row 

and column labels but organize the data differently. This method combines data that has matching 

labels from each worksheet. 

You can set up the consolidation to update automatically when the source data changes, but you 

won't be able to change which cells and ranges are included in the consolidation. Or you can update 

the consolidation manually, allowing you to change the included cells and ranges. 

1. Set up the data to be consolidated. 

2. Click the upper-left cell of the area where you want the consolidated data to appear.  

3. Select Data tab, and then select Consolidate to popup the Consolidate dialog box. 

4. In the Function box, click the summary function you want Excel to use to consolidate the data.  

5. Click the Reference box, click the sheet tab of the first range to consolidate, type the name 

you gave the range, and then click [Add]. Repeat this step for each range.  

6. If you want to update the consolidation table automatically whenever data in any of the source 

ranges changes, and you're sure you won't want to include different or additional ranges in the 

consolidation later on, select the Create links to source data check box.  

7. If you're consolidating by position, leave the boxes under Use labels in blank. Excel does not 

copy the row or column labels in the source ranges to the consolidation. If you want labels for 

the consolidated data, copy them from one of the source ranges or enter them manually.  

8. If you're consolidating by category, select the check boxes under Use labels in that indicate 

where the labels are located in the source ranges: either the top row, the left column, or both. 

Any labels that don't match up with labels in the other source areas result in separate rows or 

columns in the consolidation. 

7.3 Consolidate by Using 3-D Formulas 

When you use 3-D references in formulas, there are no restrictions on the layout of the separate 

ranges of data. You can change the consolidation any way you need to. The consolidation updates 

automatically when the data in the source ranges changes. 

7.3.1 Use formulas to combine data    

In the following example, the formula in cell A2 adds three numbers that are located in different 

positions on three different worksheets. 

 

 



   Chapter 4 

Excel for Financial Modelling and Data Analysis @ Peter Lo 2023 31 

7.3.2 Add data to a consolidation with 3-D references    

When all of your source worksheets have the same layout, you can use a range of sheet names in 

3-D formulas. To add another worksheet to the consolidation, just move the sheet into the range 

your formula refers to. 

 

7.3.3 Step to create 3-D Formulas Consolidation 

1. On the consolidation worksheet, copy or enter the labels you want for the consolidated data.  

2. Click a cell that you want to contain consolidated data.  

3. Type a formula that includes references to the source cells on each worksheet that contains 

data you want to consolidate. For example, to combine the data in cell B3 from worksheets 

Sheet 2 through Sheet 7 inclusive, you could type =SUM(Sheet2:Sheet7!B3). If the data to 

consolidate is in different cells on different worksheets, enter a formula such as this: 

=SUM(Sheet3!B4, Sheet4!A7, Sheet5!C5). To enter a reference such as Sheet3!B4 in a 

formula without typing, type the formula up to the point where you need the reference, click 

the worksheet tab, and then click the cell. 
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8. Pivot Table  

8.1 Introduction 

Imagine being faced with a pile of data that you need to organize and summarize in a hurry. And 

what’s more, you have to present the information in a way that highlights specific aspects of the 

data.  

If this sounds familiar, the PivotTable report feature in Excel could be what you’re looking for. 

PivotTable reports are interactive tables that make it possible for you to move information around, 

so that you can see how it fits together. PivotTable reports help you to organize and compare data so 

that you can see patterns, trends, and relationships. And it takes only seconds to pivot the rows and 

columns of data from one view to another, like turning a kaleidoscope to see the different patterns. 

 

8.2 When to use a PivotTable Report 

Use a PivotTable report when you want to compare related totals, especially when you have a long 

list of figures to summarize and you want to compare several facts about each figure. Use 

PivotTable reports when you want Microsoft Excel to do the sorting, subtotaling, and totaling for 

you. In the example below, you can easily see how the third-quarter golf sales stack up against sales 

for another sport or quarter, or grand total sales. Because a PivotTable report is interactive, you or 

other users can change the view of the data to see more details or calculate different summaries. 
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8.3 Anatomy of a PivotTable Report 

 

 Page field A field from the source data that you assign to a page (or filter) 

orientation in a PivotTable report. For example, grade is a page field. 

You can use the Year field to display summarized data for only 2003, 

only 2004, and so on 

 Data field A field from the source data that contains values to be summarized. 

For example, Count of studho is a data field. 

For most types of source data you can choose how to summarize data 

(for example, by sum, average, or count). A data field usually 

summarizes numbers, but it can also summarize text. For example, you 

can count the number of times a specific text entry (such as Yes or No) 

appears in a field. 

 Column field A field from the source data that you assign to a column orientation in 

a PivotTable report. For example, ethnic is a column field. 

 Item A subcategory of a row, column, or page field. For example, the ethnic 

field contains the following items: AA and L. The cela04 field contains 

these items: FB, BB, BA, PR, AD 

 Row field  A field from the source data that you assign to a row orientation in a 

PivotTable report. For example, cela04 is a row field. 

 Data area The cells in a PivotTable report that contain counted data. For 

example, the value in cell C5 counts the number of Latino students who 

performed at the Far Below Basic level on the 2004 CST ELA (42) 

 Field List List of all possible fields from the original data. 
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8.4 Create a PivotTable report 

To create a PivotTable report, use the PivotTable and PivotChart Wizard as a guide to locate and 

specify the source data you want to analyze and to create the report framework.  

You can then use the PivotTable toolbar to arrange the data within that framework. 

1. Open your original spreadsheet and remove any blank rows or columns. Make sure each 

column has a heading, as it will be carried over to the Field List 

2. Highlight your data range, select Insert tab, PivotTable group, PivotTable. 

3. Select the radio button for New Worksheet in the Create PivotTable dialog, then press [OK].  

 

4. A new worksheet opens with a blank pivot table. You’ll see that the fields from our source 

spreadsheet were carried over to the PivotTable Field List.  

 

 



   Chapter 4 

Excel for Financial Modelling and Data Analysis @ Peter Lo 2023 35 

5. Drag an item from the PivotTable Field List down to the Row Labels quadrant.  

 

Whenever possible, lay out the PivotTable report directly on the sheet so that you can view the 

data while you arrange the fields.  
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8.5 Customize a PivotTable Report 

You've now created a PivotTable report, but that's only the beginning. A PivotTable report is more 

than just a static summary; you can use it to interactively explore the data's significance. Zero in on 

the details or pull back for an overview. You decide the type of customizations you want. To 

customize your PivotTable report, do one or more of the following:  

8.5.1 Add or Remove Data 

You can easily add or remove a field—including a row, column, or page field. To add a field, drag a 

field from the PivotTable Field List window to the appropriate area on the PivotTable report. To 

remove a field, drag a field outside the PivotTable report. 

8.5.2 Quickly Rearrange the Layout 

You can quickly "pivot" the report by moving a field or reordering the items within a field. To move 

a field, drag the field to the appropriate area on the PivotTable report. To reorder items within a 

field, drag an item to a new location in the field. 

8.5.3 Rearrange the Order of Items in the Field 

Right click on the item that you want to re-order, choose order from the drop menu and decide 

where you want to move the item relative to the other items. 

 

8.5.4 Use Page Fields to View a Subset of the Data 

Each page contains a subset of the data that's summarized in the report.  

To view a different page, click the arrow next to the page field item (grade on our report), and then 

click an item in the list. 
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8.5.5 Use Custom Calculations to Fine Tune Result 

You may get a different perspective on the data by seeing the data as a percent of the items that you 

are displaying. 

1. Right-click on the data field, click Field Settings from pop-up menu 

2. In the Pivot Table Field window, click on [Options] to reveal additional choices 

3. In the Field Setting box, select the calculation you want. Try percent of total, or percent of 

column as appropriate. You can set Show data as to Normal turns off custom calculation. 

 

8.5.6 Show the Details you Want 

In a PivotTable report, you can drill down on the details or hide information for a big picture view.  

8.5.6.1 Display the underlying source data for a specific data cell 

Just double-click a cell to see its details. 
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8.5.6.2 Show or Hide Items in a Row or Column   

Click the arrow in a field, and then select or clear the check boxes you want. 

 

8.6 Pivot Chart  

A PivotChart report provides a graphical representation of the data in a PivotTable report. You can 

change the layout and data displayed in a PivotChart report just as you can in a PivotTable report. 
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8.6.1 Create a PivotChart  

1. Select a cell in a range of cells, or put the insertion point inside of a Microsoft Office Excel 

table. Make sure that the range of cells has column headings. 

2. To create a PivotTable and PivotChart report, on the Insert tab, in the Tables group, click 

PivotTable, and then click PivotChart. Excel displays the Create PivotTable with 

PivotChart dialog box. 

3. Specify a location by doing one of the following: 

 To place the PivotTable report in a new worksheet starting at cell A1, click New 

Worksheet. 

 To place the PivotTable report in an existing worksheet, select Existing Worksheet, and 

then specify the first cell in the range of cells where you want to position the PivotTable 

report. 

4. Click OK. Excel adds an empty PivotTable report to the specified location and displays the 

PivotTable Field List so that you can add fields, create a layout, and customize the PivotTable 

report.  

 

 


